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MyJuryInfo Introduction 
 
What is MyJuryInfo? 
 
MyJuryInfo is an interactive jury service website developed by the AOC.  Combined with Xerox Juror, 
MyJuryInfo allows you to reach out to your jurors in a whole new way. 
 
What does MyJuryInfo do? 
 
With MyJuryInfo: 

• Potential jurors can complete questionnaires online. 
o Court staff can enter the information from paper forms. 
o The questionnaires can be printed or emailed for attorneys. 

• Potential jurors can see information on the website. 
o Set contact information that will display for all potential jurors. 
o Display information that is specific to each pool. 
o Choose whether or not each potential juror can see their next appearance date, pool 

type, etc.  
o The potential jurors can also see the AOC’s juror orientation video and guide. 

• The court can send notices to potential jurors. 
o Send emails and text messages to potential jurors about excusals, courthouse 

closings, and upcoming court appearances. 
 
 

How does MyJuryInfo work? 
 
MyJuryInfo has 3 components: 

• Xerox Juror Software  
• MyJuryInfo Public Side 
• MyJuryInfo Court Side 

 

Juror Application 

Juror is a full service jury 
managment system (from 
summoning to payment). It 
shares information with 
MyJuryInfo . 

Juror, a Xerox product, is offered 
at no cost to the Circuit Courts of 
Arkansas through the AOC.  

MyJuryInfo Court Set-up 

MyJuryInfo Court side is the 
backend of the MyJuryInfo 
website. This is where messages 
are typed and viewed before they 
are sent to potential jurors.  Only 
court staff see this side of the 
website.  

MyJuryInfo.courts.arkansas.gov 

MyJuryInfo Public Side! 

This is the side seen and used by 
your court's potential jurors.  
Potential jurors can fill out their 
questionnaires,  sign-up for text 
messaging notices and/or can 
logon to see their status.  
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Xerox Juror Software 
 
This is the full service jury management system provided by the AOC. It handles everything from summoning 
jurors to payment. MyJuryInfo shares data with the Juror Software. If you disqualify someone in Juror, they 
are excused in MyJuryInfo and vice versa.  
 
 
MyJuryInfo Court Side 
 
This is the part of MyJuryInfo you will be working in. From here you can disqualify people, send emails and 
text messages, and print off questionnaires. This manual will go into detail on both the first time set-up and 
the daily use of MyJuryInfo Court Side. 
 
MyJuryInfo Public Side 
 
This is the part of the website the public sees. Normally, it starts with a questionnaire. Once the 
questionnaire is completed, or the potential juror attends orientation, she will see to a page displaying 
information from the court. What information she can see here is controlled by the MyJuryInfo Court Side. 
(Court staff should not log in to the public side; you can preview how it looks from the court side.) 
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MyJuryInfo Public Side 
 
Summonsing people for jury service is done in the Juror Program. In Juror, you should change the “freetext” 
on the summons to provide a link to myjuryinfo.courts.arkansas.gov. (See: Summons Printing in the Juror 
Manual) 

 
When the potential juror sees the web address on the summons, he will go to the website. 
First, he will encounter the login page. In order to login he must correctly enter his Juror Number (found on 
the summons), his last name (as it appears on the summons), and his birth date. The birth date is not located 
on the summons; this is to prevent someone else from logging in as the summoned person. He does not need 
to include suffixes when entering his name. 

 
What happens next depends on his status in Juror. If he is not responded/excused/disqualified he’ll find an 
information page letting him know what to expect, and then be sent to the questionnaire. If he is responded 
and has Bioform data in the system, he will go straight to the Home Page. 
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The questionnaire is 5 pages long. The questions are the same as on the AOC provided summons forms. Most 
questions cannot be skipped. If the potential juror misses a question that can’t be skipped, she will see a red 
error message letting her know what question she missed. If she answers a qualification question in a way 
that might make her disqualified, or if she has a disability, an alert will appear on the MyJuryInfo Court 
side. 
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If the juror was in pool status, she will become responded once the questionnaire is complete. Once the 
questionnaire is completed (or skipped) the potential juror will reach this page. 
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To the potential juror, this is a simple static page, but in reality it has several different boxes that you can 
change with MyJuryInfo Court Side. 

 
 
Blue – Cannot be modified. 
Orange – ‘Court-wide’ Settings. These are edited in the Display Settings Tab. 
Green – Group / Pool Message. This is edited in the Pool Message Tab. 
Purple – Items that are pulled from Juror. Some can be set to hide in the Display Settings Tab. 
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The Home page also has tabs to a few other pages that the potential jurors can use to update questionnaires, 
view the jury guide and video, or give feedback on their jury service experience.  
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If a potential juror is responded but has no questionnaire data in the system (he attended orientation but the 
court has not entered his paper questionnaire into the system) then we she goes to the Update My Info tab 
instead of seeing the page selector, she will see a set of options:  1) complete the questionnaire, 2) complete 
only the contact information (allows for text messaging reminders). 
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MyJuryInfo Court Side  
 
 Login Page 
 The first thing you’ll encounter is the Login page. Use the same username and password as you do in Juror. 
 
 You’ll notice in the upper right corner of the program there is a Font Size option. If you have trouble reading 
the page, please change your font to the large size, but be aware that this will make a few screens harder to 
use if you are using a smaller monitor.   
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Welcome Page  
 
The first page you will see once you login is the welcome page.   
 
This page contains a calendar that displays the events from the Juror system. The events cannot be edited 
from here, but serve as a reminder of upcoming events that you might want to send notices for. The calendar 
will show active events that are within the last year or are coming up in the future.  
 
This page also has a bold line of text letting you know how many alerts you currently have. 
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Alerts Page 
 
This is one of the most used pages of the program. Here you can see all your alerts, separated by Pool. 
 
Whenever a potential juror fills out the qualification questions online in a way that means they may be 
disqualified, an alert is created and it appears on this page. An alert is also created if a potential juror has a 
disability. 
 
On the Alerts Page you can see the name of the potential juror, which question they answered that may 
disqualify her, and her contact information. 

 
 

Email a participant that has an Alert 
You can click the email address and a new screen will pop-up.  

 
You can use the box to customize your message. The email will send from DoNotReply@arkansas.gov so if 
you want the participant to respond to you, be sure to include your contact information in the message. 
Below the message box is a place where you can add a confirmation email. This email address will get a copy 
of the email. It will default to the email address associated with your user account.  
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Remove the Alert (and change the participant’s status if needed) 
Once you have contacted your potential juror and the decision has been made whether or not to disqualify 

or excuse him, click the  icon. 
This brings up another popup. If the popup does not display, you may be blocking pop-ups.  Please see the 
section on Turning on Pop-ups section of the manual.  

 
On this screen you can see the person’s current status and choose what new status you would like to set for 
the participant. 
 
 Select the new status for the participant.  
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If you select Excused or Disqualified then a new field will appear. Select the reason why this person is 
receiving this status. For instance if a person is being excused for a health problem you could select “Health 
or Family Health.” 
 

 
 

To apply the new status hit “Save.” 
 
If you want to leave the participant as the same status he already has, hit “Dismiss” to dismiss the alert. 
 
If you clicked this record by mistake, and don’t want to remove the alert yet, hit “Cancel.” 
 
When a person has multiple alerts, you must dismiss all of the alerts separately. This is to ensure that all 
the possible disqualifications that an individual has are seen by the court. 
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The Pool Message page 
 
This is another page you will use on a regular basis. From this page you may send out notices to your 
potential jurors!  

 

Sending out a notice 
First, we need to determine who will receive the notice.  
We can start by selecting either a pool group or an appearance date. 

 or  
Once you’ve chosen whether to notify a pool or a group based on date, you next select which statuses of 
people you want to receive the message.  
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You will see on the left a list of statuses from the Juror program. Check all the statuses you wish to send 
notices to. For example, if notifying the participants about a trial date, you will most likely choose either 
responded, or pool and responded. People that are already excused will not need to know the day of the 
trial. 
 

 
If you think you have participants that have partial excuses on a day related to your notice, you can exclude 
them using the “Exclude participants with a partial excuse date of” field.  

 
Once you have selected your group and statuses, you should see to chosen records displaying at the bottom 
of the page. These are the people that will receive the notice. If there is not a list of people, then you do not 
have anyone selected to receive your notice. 

 
 

The  icon means this person has an email address, and the  icon means this person has opted-in 
to receive text messages.  
In order to keep the page loading quickly, only the first 15 records display. At the upper right hand corner of 
the list, you can see the total number of people selected.  

 
 
 Use the  button to scroll through the pages and ensure that your chosen group is correct.  
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Now that we have decided who will receive our notifications, we need to select how we will notify them. At 
the top of the page you will see three more checkboxes, one for the webpage, one for email, and one for text 
messages. Select all of the message types you wish to send. 

 
Next, we will create the notice. Type out your message in the large text area. You will notice a little arrow  
in the top right corner of the text area. Clicking this arrow to bring up the formatting bar. 

 
You can use this bar to format the text of your messages. The webpage and most email programs will display 
the formatting. Text messages will not show the formatting, just the text. 
 

Once your message is ready you can hit the send button to send the notice to your jurors. A message 
should appear at the top of the page letting you know how many of each notice type was sent.  

 
There is a box under the message box where you can input a Confirmation Email address. It will default to 
showing the email address attached to your user account. A copy of the notice will be sent to this email 
address whenever you send a notice, and will include the number of each notice type sent.  

 
  

 
 
Emails will be sent from DoNotReply@arkansas.gov. Jurors will not be able to reply to these emails. The 
court may provide a contact email address within the message. 
 
When a text is sent it will be from a generic number used by the phone provider for certain message types. It 
will begin like so: 
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FRM: DoNotReply@arkansas.gov 
SUBJ: Your Jury Update 
MSG:  
 
Keep in mind that if you make a text message too long it will send as multiple text messages. Try to keep your 
message under 100 characters if you wish to send a single message. 
 
 
When updating the webpage, you can see the text in the records, without the formatting.  

 

To see how it will actually look to the user, hit the preview icon.  
Then you will see a preview of the participant’s MyJuryInfo page. 

 

Sending a Notice to Disqualified or Excused Jurors based on date of the status change 
If you send notifications to a group of disqualified or excused participants you will be able to select a date 
range for when they were excused.  
For example, you may excuse several people in one day and want to send a notice saying: “You are excused. 
You do not need to come to court.” But you do not want to send the notice to the people you excused 
previously, since you have already notified them. 
To do this, select the excused or disqualified status checkbox, and then select a date range.  
 Select your message type and then click Send.  
This will only send the notice to individuals that were excused or disqualified on a day within the date range. 
(This is for full excuses, not partial excuses.) 

 
If you wish to send to notice to all excused or disqualified participants, just leave the dates blank. 
 

mailto:DoNotReply@arkansas.gov�
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Viewing the Preview Page 
Whenever you have a list of participants showing, you can use the Preview option to see exactly what they 
will see on their home page. We recommend you do this every time you update the webpage, or the custom 
boxes. 

First bring up a group of participants. Click the Preview button .  

 
When you are done viewing the preview, hit Back in your browser to return to the Pool Message Page. 
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Viewing the Participant’s Record 
In Juror, when you want to know something about a participant, you use the Participant’s Record screen.  
 
MyJuryInfo also has a screen for viewing a participant. 
 
To get this screen, go to the Pool Message Page. Bring up a group that the participant is in and find the 
participant in the list. 
 

 
 
Click on the participant’s Part No (Participant Number). 
 
This will take you to the Participant’s Record Page 

 
Use the  buttons to expand the information. 
 
You can also reach this page by clicking a participant’s Part No on the Alerts Page. 
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The Display Settings Page 
 
 This page will mostly be used during initial setup. However, if something changes in your court, you may 
need to come back and update the information here.  
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Changing the Custom Message Boxes 
This page is used to handle how things appear on the potential juror’s home tab. Remember the boxes we 
discussed in the public side section? This page handles changing the orange sections below. 

 

 
First, select the location for which you want to edit settings. If you only have one location, this will not need 
to be changed. 

 
Next, we will set up the Information boxes. There are three different boxes and you choose which to edit 
using the drop down. The boxes are the Welcome message, the Contact Information message, and the 
Excuse Information message.  
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The message that is currently displaying is shown below the text area.  

 
Type out your message in the large test area.  

You will notice a little arrow  in the top right corner of the text area. Clicking this arrow to bring up the 
formatting bar.  This bar has more options than the other formatting bars so that you can add images or 
videos. Adding videos is discussed in the next section.  

 

Once you’ve finished your message hit set.  
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Adding a Video from YouTube to the Custom Message Box 

To add a YouTube video first click the upper right hand arrow to open the bar.  
Select the Source option. 
 

 
 
Go to the YouTube video you want to add and hit Share and then Embed. Select the smallest available size. 
 

 
 
Highlight the embed code, right click and select copy. 
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Go to your message, right click, and hit Paste. 
 

 
 
Click Source again. You should see a box in the preview. This is where the video will appear. Add any other 

information you want to the message, and click set  when you are ready.  
 

 

Go to the pool message page. Bring up a group of participants. Click the Preview button to see exactly 
what it looks like on their page. 
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Adding images to the Custom Message Box 
To add an image to your custom message, first find the image you want to use online. You must find it online, 
the program does not allow you to add pictures from your computer. 
Right Click and choose View Image. 

 
This will take you to a page showing only the image. 
 
Once on this page go to the web address at the top of the page. Right Click an select Copy. 

 
 
Go back to MyJuryInfo and go to Display Settings. Select your location and which message box you are 
wanting to put the image in.  

 
Click the arrow to bring up the formatting bar.  

Click the Add Image button.  

 
A dialog box will appear. In the field labeled URL, right click and paste in your image’s web address. 
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Click outside the URL field. It should now show a preview of your image. 

 
 

Click OK.  
 

You can now see the image in your message box. Finish your message and click set.   

 



P a g e  | 31 
 

Go to the pool message page. Bring up a group of participants. Click the Preview button to see exactly 
what it looks like on their page. 
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Adding Links to a Message  
You can add links to a pool message (Pool Message Page), an alert email (Alerts Page), or to the custom 
message boxes that display on every jurors page (Display Settings Page). 
Once you are in a message editor, click the arrow in the upper right hand corner to open the formatting bar. 

 

 

Next click the Add Hyperlink Button.  

 
Type or paste in the web address in the URL field. The ‘http://’ part of the address will appear in the Protocol 
dropdown. Make sure it matches the site address. 

 

Click OK.  
You can now see the image in your message box. 
Finish your message and click Send or Set. 
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Showing and Hiding Information that pulls from Juror 
Information that is pulled from Juror and displayed on the public side appears in the purple section of 
the image shown below. From the Display Settings Page we can set these fields to hide or show. 

 
There are 5 fields that you can choose to show or hide. Status phrase, Date and Time, Location, 
Jurisdiction, and Pool Type. 
 
If a field is set to hide it will not display on a participant’s home tab.  For instance, if your court never 
uses the Jurisdiction field, you could set it to hide so that participants do not ask about what it means by 
‘Circuit’. 
 
Next to each field there is a box describing whether it is set to show or to hide. 
 
Simply change the box next to the field you want to update and click Save.  
 

 
 



P a g e  | 34 
 
 

The Evaluation Page   
 
On the participants side of MyJuryInfo there is a tab where they can complete an Evaluation survey. The 
Evaluation Page is how you view the answers to these surveys. 
The Evaluation Page will display how many participants from the pool completed the evaluation, an average 
of their rankings, and a list of all their comments. 
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The participant side: 

 
It’s important to remind the participants at the end of the term about the Evaluation page, so that you can 
get a large number of responses. 
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The Bioform Page 
 
 Once MyJuryInfo is available, many of your potential jurors will use the online system to complete their 
questionnaires. But there will almost always me some that mail or hand back the paper forms. You could 
print out the Bioforms that were filled out online and combine them with the scans of the paper files, but the 
forms will look inconsistent. In order to have more consistent records, it is recommended that you use this 
page to enter in the information on the paper forms.  

 

Inputting Bioform (Questionnaire) Data 
 
Begin by entering the participant number and hitting Tab.  
 
This will get the page ready to accept data for the participant. You will see the participant’s name in bold.  
 
If there is already data in the system for the participant, it will automatically load in. 

 
Fill in each question as it appears on the paper form.  
 
Once finished, hit ‘Save’. (If there is already data for this participant the button will instead say Update). 
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You should see a success message at the top of the page. 

 
If you missed a question, the page will give you an error alerting you to which question was skipped.  

 
If you entered data incorrectly and do not wish to save, hit ‘Cancel’ to clear the page.  
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The Reports Page 
 
The final tab is the Reports Page. Here you will find several reports that you can run. Click the report you wish 
to see, and you will be prompted for the information it needs. 
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Report 1: Bioform Report 
 
This report is the report you give to the attorneys containing the questionnaire information. We highly 
recommend that you print or email these for your attorneys. 
You will need to provide a pool number then hit submit. Only those pools that contain at least one Bioform 
can be selected. 

 
You should now see your report. Find the print button in your browser or hit Ctrl and P to print. 

 
If you would like to email your Bioforms, begin by finding the Save As option in your browser.  
 
There may be an easy to find button like in the image below: 
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Or you may need to go to File -> Save as  (if you don’t see the menu hold Alt) 
 

 
 
This will save the Bioforms to your computer. Find the file (try looking in the Downloads folder or on your 
Desktop) and then attach the file to an email. 
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Report 2: Roll Call Report 
 
This is a report for calling roll. It can be run for a pool or a date. It will contain all statuses, so if you wish to 
only call responded people during roll you should select to sort by Status. Then you can begin calling roll at 
the first responded name.  
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Report 3: Partial Excuse Report 
 
This report takes a date range and returns a list of all the participants that are partially excused during that 
date range. The participants are grouped by pool. 
 
 A person that is gone for multiple days will be on the list for each date. 
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Report 4: Responded without Questionnaire Report 
 
This report takes a pool and displays all members of the pool that are Responded status but have not filled 
out the questionnaire. 
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Miscellaneous  
 

Turning on Pop-ups  
The Alerts Page does not work without Pop-ups enabled. Pop-ups are required to send emails from this page 
as well as to change participant statuses and dismiss alerts. 
 
How to turn Pop-up on will be different depending on your browser. 

Internet Explorer 
In Internet Explorer you should receive a message when a pop-up is blocked. Normally you can click on the 
message and select “Options for this site” -> “Always Allow” to allow pop-ups. 

 
 
If you are using Internet Explorer and do not see this message, go to Tools -> Internet Options. (If you do not 
see the menu hit ALT) 

 
 
From there go to the Privacy tab. Under Popup Blocker hit the Settings button. 



P a g e  | 45 
 

 
 
 
Type “*.aoc.arkansas.gov” into the box and click the Add button. 
 
Then type “*.courts.arkansas.gov” into the box and click the Add button. 
 

 
Now hit Close and Okay.  
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Firefox 
 
If you are using Firefox, go to Tools -> Options. (If you do not see the menu hit ALT) 
Under the Content tab, find where it says “Block pop-up windows” and hit the Exceptions button. 
 

 
 
Type “*.aoc.arkansas.gov” into the box and click the Allow button. 
 
Then type “*.courts.arkansas.gov” into the box and click the Allow button. 
Now click Close and OK. 
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Google Chrome 
Click on the menu icon and choose Settings. 
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Click the link labeled “Show advanced settings” at the bottom of the page. 

 
 
Under Privacy click the Content Settings button. 
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Scroll down until you reach Pop-ups. Click the Manage Exceptions button. 

 
 
Type “[*.]aoc.arkansas.gov” into the box. 
 
Then type “[*.]courts.arkansas.gov” into the next box once it appears. Click Done. 
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Safari 
Go to the menu in the upper left and click Safari. 
Click Preferences. 

 
Go to the Security tab. 
Uncheck Block pop-up windows. 
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On an IPhone or IPad 
Go to your home screen and select Settings (Gear shaped Icon).  

 
Go to Safari. 

 
 
Scroll down. 
 
Change the Block Pop-ups option to off. 
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On an Android Phone or Tablet 
While in your internet browser hit the menu button. 
 
Scroll down and select Settings. 

 
 
Select Advanced. 

 
 
Scroll down. 
 
Uncheck the Block Pop-ups checkbox. 
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